Kurzweil 1000
Version 13
Installation and New
Features Guide

Copyright Information & Notices
Kurzweil 1000™ Version 13 Installation and New Features.
© by Kurzweil Educational Systems, Inc., a Cambium Learning Technologies Company. All rights reserved.
Kurzweil Educational Systems is a registered trademark of, and Kurzweil 1000, Kurzweil 3000, Kurzweil 3000
LearnStation, License-to-Go, and KESI Virtual Printer are trademarks of Kurzweil Educational Systems, Inc.
Microsoft, Windows, Windows 2003, Windows Server 2008, Windows Vista, Windows XP, Windows 7, and Windows
8 are trademarks or registered trademarks of Microsoft Corporation in the United States and/or other countries.
FineReader and FineEngine are trademarks of ABBYY USA Software House, Inc. VoiceText is copyright 2002 and
2003 by NeoSpeech Software, Inc. All other product or brand names are trademarks or registered trademarks of
their respective holders.
Component Acknowledgments:
The American Heritage® Dictionary of the English Language, Fourth Edition. Copyright © 2000 by Houghton Mifflin
Company. Published by the Houghton Mifflin Company. No part of this database may be reproduced or otherwise
used without prior written permission from the publisher unless such use is expressly permitted by applicable law.
Words are included in this Dictionary on the basis of their usage. Words that are known to have current trademark
registration are shown with an initial capital and are also identified as trademarks. No investigation has been made of
common-law trademark rights in any word. The inclusion of any word in this dictionary is not, however, an expression
of the Publisher’s opinion as to whether or not it is subject to proprietary rights, nor is it to be regarded as affecting the
validity of any trademark.
American Heritage® is a registered trademark of Forbes Inc. Its use is pursuant to a license agreement with Forbes
Inc.
Roget’s II: The New Thesaurus, Third Edition by the Editors of the American Heritage® Dictionaries. Copyright © 1995
by Houghton Mifflin Company. Published by Houghton Mifflin Company. No part of this database may be reproduced
or otherwise used without prior written permission from the publisher unless such use is expressly permitted by
applicable law.
No investigation has been made of common-law trademark rights in any word. Words that are known to have current
trademark registration are shown with an initial capital and are also identified as trademarks. The inclusion or
exclusion of any word, or its capitalization in this dictionary is not, however, an expression of the Publisher’s opinion
as to whether or not it is subject to proprietary rights, nor is it to be regarded as affecting the validity of any trademark.
Concise Oxford English Dictionary 11th edition ISBN 0198608640 © Oxford University Press 2004.
Additional product components are licensed from Bennet-Tec Information Systems, Inc.; DIRAC Time Stretch/Pitch
Shift technology © Stephen M. Bernsee; Nuance Communications, Inc.

24 Prime Park Way • Natick, MA 01760 • 800-894-5374 • Outside US and Canada: +1-508-315-6600 •
www.kurzweiledu.com/

Contents
1

Installation and Registration ................................................................... 3
What's in the Product Package? .................................................................... 3
Minimum Software and Hardware Requirements .......................................... 4
Before Installing Kurzweil 1000 ..................................................................... 4
Uninstalling Kurzweil 1000 ............................................................................. 6
Installing Kurzweil 1000 Version 13 ............................................................... 6
To install Kurzweil 1000 using the voiced installation ................................. 7
To install Kurzweil 1000 using the screen reader ....................................... 8
To install Kurzweil 1000 using the remote silent install option: ................. 10
Registering Kurzweil 1000 ........................................................................... 10
Preliminary Registration Steps ................................................................. 11
Registering Online .................................................................................... 12
Registering by Phone ............................................................................... 14
Exploring Kurzweil 1000 .............................................................................. 15

2

Tips for New Users ................................................................................. 16
Keypad or Menu?......................................................................................... 16
Using the Numeric Keypad ...................................................................... 16
Using the Menu System ........................................................................... 17
Starting and Shutting Down Kurzweil 1000 ................................................. 19
Finding Help and Information....................................................................... 19

3

Version 13 New Features....................................................................... 21
A new setting to extract bookmarks from PDF files ..................................... 21
Page 1

A new setting for the identification of bookmarks when images are
recognized ................................................................................................... 21
Multiple deletions can be made of bookmarks, hyperlinks, and notes ........ 21
The treatment of alphanumeric keystrokes in list box controls .................... 22
Repeatedly pasting a page. ......................................................................... 23
A Copy Page new menu item ...................................................................... 23
Next and Previous commands for Looking Up a Word................................ 23
OCR Upgrades ............................................................................................ 23
PDF Output using KOCRUtil........................................................................ 23
Document Camera support.......................................................................... 24
EPUB Support ............................................................................................. 25
FineReader and Bookmarks: ....................................................................... 26
Microsoft Speech Platform Runtime 11 ....................................................... 26
Voice Text Automatically Installed ............................................................... 26
Scanning Controls Positions ........................................................................ 26
New Audio Device Setting ........................................................................... 26
Additional Changes and Enhancements...................................................... 27
Have Ideas for New Features or Enhancements?........................................ 28
4 Systems Code Worksheet ......................................................................... 30

Page 2

1

Installation and Registration

This section covers the product package, the software and hardware
requirements, and installation for Kurzweil 1000™.

What's in the Product Package?
The following is a general list of contents. The items you receive may be
a subset of this list, and may depend on whether you are a new customer
or an upgrade customer, and may depend on which version you are
upgrading from.
• The Kurzweil 1000 software DVD, which includes the American
Heritage Dictionary Pronunciation WAV Files, NeoSpeech
VoiceText voices, Microsoft Speech Platform Runtime 11 Installer,
Classic Literature files, and a set of documentation in multiple file
formats.
• The Kurzweil 1000 Quick Reference Guide.
• The Kurzweil 1000 Installation and New Features Guide.
• Possibly a Certificate of Ownership bearing the serial number for
the product.

You can call Kurzweil Educational Systems Customer Service to request
any of the guides if they are not included in your package.
In the U.S. and Canada use 1-800-894-5374. For international calls use
+1-508-315-6600.
Some of the print material is available in other file formats such as MP3
from www.kurzweiledu.com.

Page 3

Minimum Software and Hardware Requirements
• Processor: 1 GHz or faster. For VoiceText, a minimum of 700 MHz is
required.
• Memory: Minimum 1 GB of RAM (32-bit) or 2 GB RAM (64-bit).
• Hard Disk Space: Minimum1 GB available space; additional 725
MB for VoiceText, and additional 340 MB if you choose to install
the American Heritage Dictionary Pronunciation WAV Files.
• Supported Operating System: Windows® 2003, Windows Server
2008, Windows XP, Windows Vista, Windows 7 and Windows 8.

Note: Microsoft Voices cannot be installed on
Windows XP.
• Microsoft® .NET Framework. Note: If .NET does not exist on your
system, Kurzweil 1000 installs it during the installation process.
• DVD drive.
• TWAIN-compatible flatbed scanner or document camera (check the
Kurzweil Educational Systems Web site, www.kurzweiledu.com, for
a list of compatible scanners and cameras). Recognizing and reading
currency requires a color scanner.
• Sound Card: Creative Labs Sound Blaster® -compatible 16-bit or
higher with speakers.
• Full-size keyboard and/or a 17-button keypad.

Before Installing Kurzweil 1000
Here are some important notes for consideration before installing
Kurzweil 1000:
• Ensure that you have administrative privileges to install Kurzweil
1000.
• The installation is designed for the novice computer user and there
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will be two options presented to you: one which uses a screen reader
and the other which uses the Kurzweil 1000 voice provided. During
the installation process, Kurzweil 1000 will ask you to specify which
you would like to use. In addition, note that the installation process is
self-explanatory, and Kurzweil 1000 provides help throughout the
process.
• After installing Kurzweil 1000, you must register the product.

Your sessions are limited to two hours until your registration is
successful. If after 30 days, you have not registered, you will no
longer have the full product.
• If you have an earlier version of Kurzweil 1000 on your system, we
recommend that you uninstall it before installing Version 13, although
it's not necessary to do so.
• There are a couple of situations in which you may not want to
uninstall. For instance, you may not want to uninstall Version 7 if you
want to keep RealSpeak English, or uninstall Version 8 or earlier if
you want to keep the RTK OCR engine.
• If Kurzweil 1000 Version 13 is already installed on your system and
you attempt to perform an install with the product DVD, a message
will indicate that it is already installed and you will then have the
option of modifying, uninstalling or repairing the current installation.
• Note that Kurzweil 1000 does not install scanners or cameras.

Use the scanner or camera manufacturer's instructions to install the
scanner or camera card, software, and the scanner or camera itself.
If you already have Kurzweil 1000 installed and you are installing a
new scanner or camera, it's not necessary to re-install Kurzweil
1000.
• Check for the latest information on the installation process from the
product Release Notes in the Readme.txt file on the Kurzweil 1000
product DVD.
• Depending on your system and the options you select, installation
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may require up to 15 minutes.

Uninstalling Kurzweil 1000
To uninstall an earlier version of the product, use the following
procedure. Note, however, that if you want to continue using RealSpeak
or RTK, do not uninstall.
1. First open the Start menu from the Windows taskbar.
2. Go to the Programs menu and select Kurzweil Educational
Systems.
3. From the Kurzweil Educational submenu, choose Uninstall
Kurzweil 1000.

Installing Kurzweil 1000 Version 13
There are two options when installing Kurzweil 1000. You can use a
screen reader or the Kurzweil 1000 voice provided. By default, Kurzweil
1000 installs in your C: drive. If you want to use a different drive or system
folder, you should use the screen reader installation method.
If you want to use the voiced installation, you must exit any screen reader
first.
Before you arrive at the place in the installation procedure where you
must choose between these two methods, the steps are the same, and
we'll cover them now.
1. Make sure you have Administrator privileges.
2. Shut down all applications. Make sure your speakers are plugged
in, and set the volume to comfortably hear the screen reader.
3. Place the Kurzweil 1000 DVD in your system's DVD drive. The
auto-install process begins. If it doesn't, choose Run from the
Windows Start menu. Type: your DVD drive letter, followed by
:\setup.exe, then press ENTER to start the setup program.
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4. Next, Kurzweil 1000 asks you to choose between voiced installation
or screen reader installation. To use the Kurzweil
5. 1000 voiced installation, press the ENTER key. To use the screen
reader installation, press the ESCAPE key.

Here the installation process diverges. This guide presents the Voiced
Installation first followed by the Screen Reader Installation. If you are
planning on using the screen reader, skip over the following section.
Note: Because Kurzweil 1000 requires the .NET Framework, the
Kurzweil 1000 installer checks for it. If it does not exist on your system,
the installer installs .NET before installing Kurzweil 1000. The .NET
install could take about 15 minutes.

To install Kurzweil 1000 using the voiced installation
This procedure assumes that you have completed the Preliminary Steps
and have pressed ENTER to use the voiced installation. Before
continuing with the installation, however, note the following keyboard
keys and their numeric keypad equivalents, which you can use
throughout the voiced installation process:
• ENTER key or Accept (top-right key on the keypad) for Yes.
• ESCAPE key or Cancel (top-left key on the keypad) for No.
• F1 key or the Help and Status key (bottom-right corner on the
keypad) for Help; Kurzweil 1000 repeats the prompt.
• BACKSPACE key or Rewind (left-most key in row 4 on the keypad) to
go back to the previous prompt.

Continue the voiced installation with the following steps:
1. A prompt asks if you want to modify the installation options.
Press ESCAPE to perform a default installation, or ENTER to
modify the options. The default installation installs everything
except optional features such as Microsoft Speech.
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2. If you chose to customize your installation options, the system asks
if you want to install the following items. After you hear the name of
the item, press ENTER to install or ESCAPE to not install it. The
items are Eloquence American English, Eloquence British English,
and six Eloquence European languages. Finally, you'll be asked
about bilingual dictionaries, and additional FineReader selections.
3. Next, the system asks whether or not you want Kurzweil 1000 to
start automatically each time you start your system. Press ENTER if
you do not want Kurzweil 1000 to start automatically or press
ESCAPE for auto-start.
4. Press ENTER to confirm your choices and proceed with the
installation.
5. Sometimes computers need to be shut down and restarted in order
to complete an installation. If that is necessary, a prompt will ask
whether you want to Restart your computer now or later. (If you
choose later, remember that in order to start Kurzweil 1000, you
should Restart the system first.) If you elected not to have Kurzweil
1000 start automatically, you can use CONTROL+ALT+K to start
Kurzweil 1000. (You may need to Restart your computer first for this
keyboard shortcut to take effect.)
6. At this point, you may remove the Kurzweil 1000 DVD.
7. Once Kurzweil 1000 starts up, it reads the license agreement.
Press ENTER to accept the agreement.
8. Go to the section entitled, Registering Kurzweil 1000, to register the
product.

To install Kurzweil 1000 using the screen reader
This procedure assumes that you've completed the Preliminary Steps
and have pressed ESCAPE to use the screen reader for installation.
Continue the installation with the following steps:
1. Type your user name.
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2. Press the TAB key to go to the organization name. This is an
optional entry. If you are using Windows XP, there is an additional
option: "Install this application for: Anyone to use..., or Only Me .... "
TAB to go to this option, and select the Anyone to use option. Press
ENTER to continue.
3. Next, press ENTER for Complete install and go to step 8.
4. If you'd rather customize your installation, or you want to place
Kurzweil 1000 on a different drive than the default C drive or in a
different folder: Press TAB to select Customized.

The Custom Setup dialog opens. The Custom option installs just the
files you leave selected in this box. The following are changes you
can make:
o To remove the feature files you don't want, use the UP/DOWN
ARROW keys, stop when you hear the name of the file you don't
want and press the SPACEBAR. You cannot remove Main files
as they are necessary for Kurzweil 1000 to function.
o To change the drive or location in which to place Kurzweil 1000,
select Main Files, and then press TAB to go to the Change
command. Press ENTER. In the Change dialog, type the name
of the desired drive and or location, or press SHIFT +TAB to
select another location. Press ENTER to close the dialog.
When you are finished, press ENTER to continue with the
installation.
5. Next, the system asks whether or not you want Kurzweil 1000 to
start automatically each time you start your system. Press ESCAPE
for auto-start. Press ENTER if you do not want Kurzweil 1000 to
start automatically.
6. The system may prompt you to Restart the computer. If it doesn't, or
after you have restarted your computer, you can use
CONTROL+ALT+K to start Kurzweil 1000. (You may need to
Restart your computer for the keyboard shortcut to take effect.)
7. Once Kurzweil 1000 starts, it reads the license agreement. Press
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ENTER to accept the agreement.
8. Register the product. Go to the section entitled, Registering
Kurzweil 1000.

To install Kurzweil 1000 using the remote silent install option:
The remote silent install installs Kurzweil 1000 to Client computers
across a Local Area Network from a central location. If you are a
standalone user, please skip this section. This option is provided for
Network Administrators who are knowledgeable about MSI packages
and have the tools to operate directly on an MSI package.
• Microsoft .NET Framework 3.5 and Microsoft .NET Framework 4.0
client must already be installed before using MSI.
• You will need to specify AUTO= 1 (a numeric value) for the Kurzweil
1000 v.13.msi package.
• You must also use the Reduced UI option.

An example to launch Version 13 through command line follows:
msiexec.exe /i "Kurzweil 1000 v.13.msi" AUTO=1 /qr
where /i is the install switch and /qr is the Reduced UI switch.
If the Reduced UI option is not available, you will need an additional MSI,
found at ftp://ftp.kurzweiledu.com/pub/K1000UIAction/. Use the second
MSI after you finish the first main install.

Registering Kurzweil 1000
When you first install Kurzweil 1000, it is in Demonstration mode. In this
mode, all features will be available, but each session is limited to two
hours. After 30 days, the product expires. To use the full product right
away, it's important that you register.
Before you register, here are a few things you must do and know:
1. Consider how you want to register. You can register Online through
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the software if your system has an Internet connection, or by
telephone.
2. Also have the serial number ready. We provide this in both print and
Braille in the following places: on your Certificate of Ownership card
enclosed with the documentation packaging, (this is a square card
with the upper-right-corner cut away), on the outside of the product
box, and on the DVD holder.
If you are upgrading from Version 7 or later, you should use the
same serial number with which you registered previously, and the
system will remember that number for you.
If you are upgrading from an earlier version than Version 7, you will
receive a new serial number.
If you purchased multiple Kurzweil 1000 licenses, the serial number
for the set is the same.
During the registration process, you can type or scan the serial
number from any of the sources mentioned above.
3. Note the Kurzweil 1000 Customer Service contact information.
4. In the U.S. and Canada use 1-800-894-5374. For international
calls use +1-508-315-6600. Each one of the registration methods
is straight-forward, but, if after repeated unsuccessful attempts, you
still need assistance, please call us.

Preliminary Registration Steps
1. In Kurzweil 1000, open the Help menu. You can use ALT+H.

Then press G to select Register.
The first of multiple Registration dialogs opens. Some of the
dialogs you'll use during the registration procedure have theNext
and Back commands. Press ALT+N or the ENTER key to go to the
next dialog and ALT+B or ESCAPE to go back to the previous one.
To get from one item to another, press the TAB key. In the first
dialog, your cursor is in the Serial Number box.
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2. Type in or scan the serial number.

If you've registered before, the Serial Number box already
contains the number.
Otherwise, to scan the serial number, place the Certificate of
Ownership card, product box, or DVD holder, face down in the topleft corner of a flatbed scanner or face up in the top-right corner of
your document camera’s target area. Press the TAB key until you
hear "Scan." Press ENTER. Kurzweil 1000 scans the serial
number directly into the Serial Number box in this dialog.
3. Press TAB then press ENTER to open the next dialog box.
Kurzweil 1000 asks you to select the registration method you want
to use. Your cursor is in a list box and the options include:
Online or Telephone. The Online option is the default.
Use the UP or DOWN ARROW to select the desired option.
4. Press ENTER to open the next dialog. Skip to the instructions for
the registration method you selected.

Registering Online
To use this method, your system must have an Internet connection. If you
have a firewall, it must be configured to accept Internet access requests
from Kurzweil 1000. Otherwise, you will receive messages from the
firewall indicating that an unauthorized application is attempting to use
the Internet. You will need a screen reader or an assistant to configure
the firewall, or you may call Kurzweil 1000 Technical Support. In the U.S.
and Canada use 1-800-894-5374. For international calls use +1-508315-6600..
1. After selecting online registration, one of two things can occur:
•

Page 12

If you have an existing serial number, and it is associated with only
one account, Kurzweil 1000 congratulates you and tells you that
you have been automatically registered. It then asks if you want to

update your account information. If you answer Yes, Kurzweil 1000
automatically fills in your account information in subsequent
Registration screens. Make the desired changes and press ENTER
to complete registration.
•

Otherwise, a dialog opens with the cursor in the Account Type box.

2. If a dialog opens, you can select New or Existing in the Account
Type box.

Select New if you are registering for the first time or with a new
serial number. Then go to step 3.
Select Existing if you’ve registered before. Go to step 3.
Select Existing - Request Information if you've registered before, but
have forgotten your password. Press ENTER.
When Kurzweil 1000 finds your information, it sends the details to
your e-mail account. Check your e-mail for the information, then
begin the online registration process again. This time, select
Existing in the Account Type box.
If Kurzweil 1000 is unable to find your information, you may have to
call Kurzweil Educational Systems Customer Service. In the U.S.
and Canada use 1-800-894-5374. For international calls use +1508-315-6600.
3. In the Account name text box, type your account name. Then TAB
to type your password in the Password box.

If you are creating a new account, pick a unique name that’s easy
to remember such as your e-mail address. After typing your
password, TAB to retype it in the Confirm Password box.
Note: It’s a good idea to note this information for future reference,
as when you upgrade to the next version.
4. Press ENTER to connect to the Kurzweil Educational Systems
Online Registration page.
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The system verifies that you are online, the server is up, the
account exists, and that the password is correct. If it finds
information that is incorrect or incomplete, it prompts you to make
the necessary changes.
Your cursor is in the first of a few online registration dialog boxes.
The system prompts for information that is mandatory.
5. Provide or change information. Press ENTER to proceed through
these dialog boxes.
6. Press ENTER when you are done.

If registration is successful, Kurzweil 1000 congratulates you. The
full Kurzweil 1000 product is now activated.

Registering by Phone
Two notes regarding phone registration:
• If you are installing and registering Kurzweil 1000 on multiple
machines, then we recommend using the Systems Code Worksheet
at the end of the Guide. You can note the systems codes, serial
numbers and unlock codes, which can greatly expedite the
registration process.
• Customer Service representatives are available to take your
registration between 8:00 a.m. and 4:00 p.m. Eastern Time. In the

U.S. and Canada use 1-800-894-5374. For international calls
use +1-508-315-6600.
The phone registration process follows:
1. Type the unlock code number.
2. Press ENTER.
3. If registration is successful, Kurzweil 1000 congratulates you.

Your Kurzweil 1000 product is now activated.
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Exploring Kurzweil 1000
You may want to explore the following helpful resources:
•

First, in the Readme.txt file in the root folder of the DVD, you'll find
information on the latest features and changes in Kurzweil 1000.

•

The second is the \Extras folder, which contains applications that
some of our customers have found to be useful.
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2

Tips for New Users

There are a couple of ways to learn how to use Kurzweil 1000:
• Go through the New User’s Wizard topics included in the product.
The Wizard appears upon Kurzweil 1000 startup, however, you can
also access it by pressing the following key combination: ALT+H+W.
• Or you can browse the online Help manual, accessible by pressing
the following keys: ALT+H+O.

This Tips chapter, however, is designed to give you a jump start.

Keypad or Menu?
There are two different approaches to using the Kurzweil 1000. If you are
comfortable with a computer keyboard and already use Windows
applications, you might want to use the Kurzweil 1000 menu user
interface.
If you want a simpler introduction to the product, start by learning the
numeric keypad user interface. There are built-in help systems and
documentation for both approaches. You may not want to limit yourself to
one or the other. If you are a Windows user and like using the computer
keyboard, consider using the keypad interface as a way to quickly access
frequently used functions.

Using the Numeric Keypad
The most important key on the keypad is the Help and Status key in the
lower-right corner. To find out a key's function, tap the Help and Status
key then tap a key you want to identify.
To get a longer, more descriptive explanation of a key's use, tap Help
and Status, then press and hold down the desired key.
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Some keys have different functions when they're shifted. You can get
help on a key's shifted function by tapping the Help and Status key, then
holding down the Shift key and pressing the key for which you'd like
information.
Four other frequently used keys are:
• Start and Stop Scanning. It's the long vertical key above the Help
and Status key.
• Start and Stop Reading. It's the long horizontal key in the lower- left
corner of the keypad. This key also acts as a Shift key.
• Cancel, in the upper-left corner, cancels an action that requires
confirmation.
• Accept, in the upper-right corner, completes an action that requires
confirmation.

At any time, you can get Help from the Online Manual by holding down
the Shift key (the long horizontal key in the lower left corner of the
keypad) and pressing the Help and Status key.

Using the Menu System
The following are general notes about using the Menu System:
• Pressing the ALT key on the keyboard gives you access to the main
menu bar.
• You can then use the LEFT and RIGHT ARROW keys on the
keyboard (not the keypad) to move among the main menus. As you
move to each menu, Kurzweil 1000 speaks the menu name.
• Use the DOWN ARROW key to open a menu and move through its
items. Kurzweil 1000 speaks a message if an item opens a dialog, if it
has a submenu, or if there is a shortcut keystroke. Use the RIGHT
ARROW key to access a submenu.
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• To select a menu item, press the ENTER key on the keyboard. If the
item has a dialog, that action opens the dialog.
• To get information about a menu item or any part of a dialog, press
the F1 key.
• To access the online manual, select Open the Manual from the Help
menu.

There are also mnemonics, or letter keys that you can press with the ALT
key, for speedy selection of menu items. For instance, pressing the ALT
key, then the letter H key for the Help menu, and the letter O key for Open
the Manual opens the Kurzweil 1000 online manual. As you become
familiar with the Kurzweil 1000 menus and their items, using mnemonics
will become second nature.
Consider memorizing shortcut keys for menu items you use frequently.
Shortcut keys are one to two keys that you press to perform an action.
For instance, the F5 Function key Starts and Stops Reading, the F9 key
Starts and Stops Scanning, and the F1 key provides help. You can also
use standard Windows shortcuts such as the Control key plus letter O to
open a file.
Another useful Kurzweil 1000 specific shortcut is Shift plus F9 to
recognize currency. While reading, the following shortcuts can be very
handy: F12 and F11 increases and decreases reading speed, respectively.
Control plus D defines a word. Control plus F lets you find text and Control
plus G takes you to a desired page.
For a comprehensive list of shortcuts, use the Quick Reference from the
Help menu by pressing ALT plus H, then Q any time while you are using
Kurzweil 1000.
Once you have opened the manual, you can, of course, just read it using
F5. But since it is a lengthy document, you might prefer to use an index.
Press CONTROL+R to access a list of bookmarks. You can move among
those bookmarks with the Up and Down Arrow kes. Bookmarks have a
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structure like an outline. The topmost level will contain chapter titles. You
can burrow deeper into the details of a chapter by pressing the Right
Arrow, which takes you to subchapter titles. When you have found a
subject that interests you, press Enter, and you will be taken to that
section in the manual. Finally, CONTROL+F, or Find, allows you to
search for a word or phrase in the manual, or in the list of bookmarks.

Starting and Shutting Down Kurzweil 1000
There are three additional helpful shortcuts to know. If you do not have
Kurzweil 1000 starting up automatically when you start up your
computer, you can start Kurzweil 1000 by pressing Control+Alt+K.
To shut down Kurzweil 1000 using the keypad; press the Cancel key
twice, followed by the Accept key. To do so with the menu system, use
the Exit menu item under the File menu, or ALT+F, and then X. To power
off your computer, which you can do only through the keypad, press the
Cancel key three times followed by the Accept key.

Finding Help and Information
Wherever you are in the product, Kurzweil 1000 provides audio feedback
through the Verbosity feature and the messaging system. However, the
following is a short list of the many ways in which you can find additional
Help and information:
• The F1 key gives you information about the current control.
• The F2 key provides Help for the current dialog box.
• For the Online Help Manual, press ALT+H, then O. In the manual,
you can use Bookmarks and the Find feature to go to and/or search
for the information you want. Press CONTROL+R to access
Bookmarks. You can move among bookmarks with the Up and Down
Arrow keys. Bookmarks have a structure like an outline. The topmost
level will contain chapter titles. You can burrow deeper into the details
of a chapter by pressing the Right Arrow, which takes you to
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subchapter titles. To go to a desired subject, press ENTER. You can
use CONTROL+F, or Find, to search for a word or phrase in the
manual, or in the list of bookmarks. Note that on the keypad, pressing
the Shift (the long horizontal key in the lower left corner of the keypad)
and the Help and Status keys opens the manual.
• There's also a Quick Reference, which provides a comprehensive list
of shortcut keys. Press ALT+H, then Q to open the Quick Reference.
• If you want information about the version of Kurzweil 1000 that you
are using, press ALT+H, then A.
• A good way to find help is through other users. You can do this by
signing up for the Kurzweil 1000 e-mail listserv. Go to the following
Web page:
http://www.kurzweiledu.com/support_listserv_signup.asp or send
an e-mail to imailsrv@kurzweiledu.com

The body of the message should contain one line. If you are sending
the message from the e-mail account that you wish to use for the list,
the message should simply read as follows: subscribe K1000.
If you intend to use a different e-mail address for the list, then the
message should read as follows: subscribe K1000 followed by the email address.
• You can also search archived questions and answers. Go to:

http://www.kurzweiledu.com/support_listserv_search.asp
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Version 13 New Features

For the most up-to-date feature information, refer to the Readme file on the
product DVD.
The following is a summary of what’s new in Version 13. For complete
details, go to the online Manual by pressing Alt+H+O. Where applicable,
Search key words are provided for you to use in the online Manual.

A new setting to extract bookmarks from PDF files
In the conversion settings dialog, a new setting has been added for
opening PDF files called Extract Bookmarks. Its mnemonic is ALT+X.
Possible choices are Enabled and Disabled. By default it is enabled. If
enabled, bookmarks which were found in the PDF file will automatically
be transferred to the resulting KES file.

A new setting for the identification of bookmarks when
images are recognized
In the recognition settings dialog, a new setting has been added. It can
be found immediately below the Table Recognition menu item, and is
labeled "Identify Bookmarks". Its mnemonic is Alt+M. Possible choices
are Enabled and Disabled. By default it is enabled. If enabled,
bookmarks will be identified as long as Fine Reader is chosen as the
recognition engine, and as long as the source is not a PDF file from
which bookmarks have already been extracted.

Multiple deletions can be made of bookmarks,
hyperlinks, and notes
You have always been able to delete one bookmark, hyperlink, or note
at a time in the dialog that shows those objects. When bookmarks are
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arranged in reading order, you were also able to delete all bookmarks
that are underneath a particular bookmark in one operation. Now you
will also be able to check bookmarks, hyperlinks, or notes in the
appropriate dialog, and delete all checked objects at once. To check an
object, move to it and use the space bar. In the same manner, you can
uncheck an object that has already been checked. You can also choose
to check all of the objects in a dialog by moving to the list of such
objects, and pressing Control+A. All checked objects can be deleted by
using the Delete button in the dialog, or pressing the delete key. Note
that if multiple objects are checked, you will be asked to confirm the
deletion. The checked or unchecked state of an object is not preserved
between invocations of the dialog - when you enter one of these dialogs,
all of the objects will be unchecked. You can also choose to delete not
just a bookmark, but all bookmarks beneath it by pressing
Control+Delete when the appropriate bookmark is selected or checked.

The treatment of alphanumeric keystrokes in list box
controls
Most of the controls in Kurzweil 1000 that allow for a selection of one
item from a list of items use a list box. The way in which one could
select an item from a list box using an alphanumeric keystroke was fairly
simple - if the key you pressed represented a character that could be
found as the first letter or number in the text of an item in the list, that
item would be selected. We've changed this to approximate the
approach used by a list view menu item instead. If you type slowly, it
works in the same way. But if you type a second character quickly, an
attempt will be made to find an item in the list whose first two characters
match what you typed. If a match is found, that item will be selected.
The same logic applies for the third character, and any other characters,
as long as the pause between the typing of characters is less than one
quarter of a second.
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Repeatedly pasting a page.
You can now paste a page more than once. This is a simple way to
effect a copy operation for pages. You can now cut the page,
immediately paste it back in place, then move to another spot or another
document and paste it again.

A Copy Page new menu item
A new menu item has been added. It can be found in the Edit menu,
immediately below the Cut Page menu item. Its mnemonic is ALT+Y. A
copy will be made of the current page. This copy can only be used in a
Paste Page operation. You can paste the page as often as you wish.

Next and Previous commands for Looking Up a Word.
If you entered a word to be looked up in the dictionary dialog and then
pressed ALT+N for next or ALT+P for previous definition, you would be
told that you needed to enter a word. Now it will simply perform the
lookup, and, if successful, will position you in the text box that contains
the first definition, and begin reading it.

OCR Upgrades
OCR upgrades: Kurzweil 1000 Version 13 now supports FineReader 10
and ScanSoft 18 in both Kurzweil 1000 and KOCRUtil. As a consequence,
the list of possible Kurzweil 1000 recognition languages and the KOCRUtil
list of output formats have changed.

PDF Output using KOCRUtil
If you choose FineReader as the OCR engine, you can now select PDF
as an output format in KOCRUtil. Kurzweil 1000 retains the image,
format, and the text data.
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Document Camera support
Document camera support, coupled with improvements in the OCR
engine, greatly improves the speed with which a hardcopy book can be
recognized and made available to Kurzweil 1000. In addition to the
cameras manufactured by ABISee supported in version 12.04, Kurzweil
1000 Version 13 supports:
•

SCEye, a ten megapixel camera developed in Germany, available
from Kodak in the United States.

•

The HoverCam portable, 5 megapixel Document Camera, available
from the manufacturer, Practical Peripherals, and various other
sources, such as Amazon.com. The HoverCam produces high-quality
images of any material that will fit within an 11" by "14" area so you can
recognize and read it in Kurzweil 1000.

There are multiple models of HoverCam that are compatible with
Kurzweil 1000, including HoverCam T3, T5, and T5V for visually
impaired. The T5V is the model we recommend. It includes special
focusing adjustments, depth of field that accommodates uneven
surfaces, a Braille-enabled rubber positioning mat, and a special
bumper for calibrating.
Support for these additional cameras resulted in the following changes:
• In the Scanning Settings dialog, the Scanner Sources list will show
the connected camera’s name. Note that selecting a document
camera may change or remove associated options, such as the
resolution setting, as it is not possible to change the resolution
setting for document cameras.
• Also in the Scanning Settings dialog, there is a new control, Light
Source (shortcut L) that lets you enable (turn on) or disable (turn off)
the light for the selected scanner or camera. (Note that not all
cameras have a selectable light source.)
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• On the Scan menu, a new item, Preview (shortcut V) opens a dialog
and displays real-time view of what is under the camera, providing an
aid for adjusting material for scanning. From within the dialog, you
can start a scan by activating the Acquire button or pressing Enter. A
camera sound indicates that the image has been acquired, and
recognition is done. There is also a Cancel button in the dialog that
does not cancel the currently active recognition; instead it closes the
dialog. You can also acquire an image from a selected camera using
the Scan->Start New Scan menu item, or with the F9 shortcut.
• In the Verbosity settings dialog, there is a new Camera Image
Capture event for the completion of an image capture from a camera.
The default wave file plays a camera click.

To capture an image with a document camera:
1. Make any adjustments to workspace, lighting, possible
obstructions, connect and set up the camera hardware, and have
the material for scanning ready.
2. Launch Kurzweil 1000.
3. Place the material for scanning.
4. In Kurzweil 1000, go to Scan Settings. Set Scanner source to the
name of the USB Video Device. Set page mode to 1 or 2 page.
Keep the default resolution setting. Press Enter.
5. Start the scan.

You should hear the sound of a camera click.
The recognized text will appear in a Kurzweil 1000 window.

EPUB Support
EPUB support is an exciting new feature of Kurzweil 1000 Version 13.
Now you can open documents with the EPUB file extension. The opened
file will behave like a DAISY document. The more important aspect of this

Page 25

feature is that you can also output files to the EPUB format by using the
File / Save dialog and specifying the EPUB extension for the file name, or
selecting EPUB from the list of available formats. This means you can now
use Kurzweil 1000 to convert hard copy to EPUB files, which can then be
transferred to most e-readers, portable audio / video players, and mobile
communications devices.

FineReader and Bookmarks:
FineReader 10 supports automatic bookmarking of recognized
documents based on text font and positioning. Kurzweil 1000 retains
these bookmarks. Further, if you use FineReader in KOCRUtil and create
RTF as output, when you open that RTF file in Kurzweil 1000, you'll find
that bookmarks are automatically generated.

Microsoft Speech Platform Runtime 11
Version 13 supports Microsoft Speech Platform Runtime 11, which means
additional voices in a variety of languages are available. This feature is
optional and is not automatically installed; the installer is provided in the
MicrosoftSpeech folder on the Kurzweil 1000 Product DVD.

Voice Text Automatically Installed
VoiceText no longer requires a separate installation; it is automatically
installed when you install Kurzweil 1000 Version 13.

Scanning Controls Positions
On the Settings menu, Scanning tab: the scanner resolution control is now
positioned immediately after the scanner source control, as it is necessary
to initialize the scanner before the scanner resolution choices can be
known.

New Audio Device Setting
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You'll find a new setting in the Settings->Voices dialog. The control's
name is "Audio Device", and its mnemonic is ALT+D. If you have
multiple working audio output devices on your computer, there are some
choices. For those who have only one audio device, only the default
audio device will be shown. If you have more than one, the first choice
will be simply called "default". In this case, the default output audio
device, as specified by the control panel application, will be used.
Otherwise, you can select another choice.
One warning - the voice that reads the choice will itself have its audio
device changed by down arrowing through this list. If some of them don't
speak (perhaps because you don't have a headphone connected or the
volume is down) you may hear nothing. Don't panic - just keep arrowing
through the list, which is circular. Like most settings, this one can be
accepted by pressing enter or activating the Apply button, and will stay
in effect only until settings are altered (which happens automatically
when you start the product, for example). You can also save this setting
using the Save Settings or Save Partial Settings menu item. Thanks
to Robert Englebretson, who suggested this feature.

Additional Changes and Enhancements
• For the most up-to-date list of changes, please refer to the Read
Me file on the product DVD.
• File Properties Changes. There are extensive changes to the File
Properties dialog to accommodate the reading and modification of
metadata components of EPUB and DAISY.
• The DOS Name field has been removed.
• Immediately after the Attribute field, there are several new controls.


Location (shortcut L) – a read only text box, presents the
folder name where the document was found.



Three modifiable text boxes follow: Title (shortcut T), Author
(shortcut H), and Key Words (shortcut K).
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Next is the Status list (shortcut U) with three statuses "Scanned", "Edited", and "Finished".



Two more modifiable text boxes are next: Identifier (shortcut
K), and ID Scheme (shortcut M).



Last is the old Statistics block, which has not changed.

• All of the new properties are enabled and available only when you
are getting properties for a single, currently open document. If you
make a change and accept it, the change will be saved only when
you save the document.
• All of these properties are retained by KES documents, and all but
Status are retained when you save DAISY or EPUB documents.
Status, for a DAISY or EPUB document, will always be “Finished”.
Other formats, such as Word or Text, do not support the retention of
these new properties.
• Verbosity Changes. The Verbosity Settings dialog has substantial
changes to accommodate the growing list of verbosity events.


The single list containing all of the events has been replaced
with a new list box at the top of the dialog pane, labeled
Category (shortcut ALT+C). The categories are: Keyboard
Focus, Reading, Dialogs, Menus, and Scanning and
Recognition. After selecting a category, tab to the next
control which presents the list of events, limited to the
events for the selected category.



Under the Scanning and Recognition verbosity category,
there is a new Camera Image Capture event for the
completion of an image capture from a camera. The default
wave file plays a camera click.

Have Ideas for New Features or Enhancements?
Wondering what we might include in the next version? Have an idea for a

Page 28

new feature or an enhancement? Use the Kurzweil 1000 listserv. To sign
up for the Kurzweil 1000 e-mail listserv go to
http:// www.kurzweiledu.com/support_listserv_signup.asp
or send an e- mail to imailsrv@kurzweiledu.com.
The body of the message should contain one line. If you are sending the
message from the e-mail account you wish to use for the list, the
message should simply read as follows: subscribe K1000.
If you intend to use a different e-mail address for the list, then the
message should read as follows: subscribe K1000 followed by the e-mail
address.
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4 Systems Code Worksheet

If you are installing and registering Kurzweil 1000 from multiple
machines, and are using the phone registration option, completing the
worksheet provided on the next page before calling Customer Service
can help to expedite the process.
As you go through the installation process note these numbers for each
machine. They are necessary for obtaining a corresponding unlock code,
which you will then need to activate each installation of the software.
Space is also provided on the worksheet for the location of each
machine, and for the corresponding unlock code which the Customer
Service representative will provide to you.
For complete details and instructions on product registration, and
specifically, Registering by Phone, go to Installation and Registration at
the front of this Guide.
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